Opportunities for Linking Biomonitoring to Risk Assessment and Public Health in the National Children's Study

EPA/ICCA Biomonitoring Workshop, Sept. 24-25, 2007

Jim Quackenboss
US EPA, ORD/NERL
NCS Interagency Coordinating Committee (ICC)
NCS Program Office

US Department of Health and Human Services
NIH, CDC, NCHS, OS

US Environmental Protection Agency
ORD, OCHP
Today’s Presentation

- Overview of the National Children’s Study (NCS)
  - Background
  - NCS Research Plan
  - Proposed Measures
- NCS and Risk Assessment
- NCS and Public Health
National Children’s Study

- Largest long-term study of children’s health and development ever to be conducted in the U.S.
  - Approximately 100,000 children to allow study of important but less common outcomes
- Longitudinal study of children, families, and their environment
  - From before/early pregnancy to age 21
- Environment defined broadly
  - Chemical, physical, behavioural, social, cultural
- A platform for children’s environmental health research
Study Concepts

• Aims
  • Identify potential environmental effects: harmful, harmless, helpful
  • For important conditions and diseases of children, identify potential preventable causes

• Hypothesis driven

• Exposure begins with pregnancy

• Has power to study high priority conditions (n~100,000)

• Gene environment interaction

• National resource for future studies
Hypotheses Necessary for Framing the Study

- Assure answers to “big issue” questions
- Hypothesis required for costly elements
- Input from >2500 scientists, others
- Important for child health & development
- Requires and measurable with sample ~100,000
- Evolving with the science
- Updated hypothesis statements in Research Plan
# Priority Exposures and Health Outcomes

<table>
<thead>
<tr>
<th>Priority Exposures</th>
<th>Examples</th>
<th>Priority Health Outcomes</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical Environment</strong></td>
<td>Housing quality, neighborhood</td>
<td><strong>Pregnancy Outcomes</strong></td>
<td>Preterm, Birth defects</td>
</tr>
<tr>
<td><strong>Chemical Exposures</strong></td>
<td>Pesticides, phthalates, metals, air &amp; water quality</td>
<td><strong>Neurodevelopment &amp; Behavior</strong></td>
<td>Autism, schizophrenia, learning disabilities</td>
</tr>
<tr>
<td><strong>Biologic Environment</strong></td>
<td>Infectious agents, endotoxins, diet</td>
<td><strong>Injury</strong></td>
<td>Head trauma, Injuries requiring hospitalizations</td>
</tr>
<tr>
<td><strong>Genetics</strong></td>
<td>Interaction between environmental factors and genes</td>
<td><strong>Asthma</strong></td>
<td>Asthma incidence and exacerbation</td>
</tr>
<tr>
<td><strong>Psychosocial milieu</strong></td>
<td>Families, SES, institutions, social networks</td>
<td><strong>Obesity &amp; Physical Development</strong></td>
<td>Obesity, Diabetes, altered puberty</td>
</tr>
</tbody>
</table>
Time Line for the NCS

2000-present  Pilot studies/methods development
2004    Developed Study Design and Study Plan; Posted Requests For Proposals: Coordinating and Vanguard Centers
2005    Awarded initial contracts (Coordinating and Vanguard Centers)
2007    Completion of the first phase of the Study protocol
2007    Award Wave I Study Center contracts
2008    Reviews and approvals (OMB, Peer review, IRB’s)
2008*   Repository and Laboratory procurements
2008-2009* Additional Center and Location procurements (wave 2&3)
2008-2009* Begin pilot cohort at Vanguard Centers (VCs)
2009-2014* Begin full Study at VCs and additional Centers
2010*    First Study results become available (methods, pilots, preliminary findings)
2015*    Full data set for outcomes of pregnancy

*Pending funding
Funding for the NCS
(as of April 2007)

- FY 2000-06: ~ $50m from existing budgets of NICHD/EPA/CDC/NIEHS
  - Infrastructure: Study Plan; Coordinating Center and 7 Vanguard Study Centers...
  - Scientific development: 30 workshops, 20 scientific reviews, 19 pilot studies; hypotheses, exposure and outcome measures, protocol in progress...
- FY 2007: **$69m appropriated February 14**
  - Prepare for recruitment and enrollment at VG Centers
  - Develop Information Management System
  - Establish additional centers for expanded locations toward full sample
- To conduct the full Study: FY ’08-’34 ~ $3 B
The NCS Research Plan

• The background, design and measures to describe what will be done and why.
• Designed for review
• 600+ pages
• On the NCS website: www.nationalchildrensstudy.gov
Study Sample

All Births in the Nation

Sample of Study Locations

Sample of Study Segments

Study Households

Study Women

~4 million births in 3,141 counties

105 Locations

Selection of neighborhoods

All or a sample of households within neighborhoods

All eligible women in the household
National Children’s Study Locations

Vanguard locations: Study Centers awarded (bold)

- Lincoln, Pipestone, and Yellow Medicine Counties, Minnesota
- and Brookings County, South Dakota
- Salt Lake County, Utah
- Waukesha County, Wisconsin
- New York City (Queens), New York
- Montgomery County, Pennsylvania
- Orange County, California
- Duplin County, North Carolina

February 2006
Schedule of Visits

- 13 face-to-face contacts over the 21 year study period
- Contacts most frequent early in the study
- Between visits ongoing data collection by phone, mail, etc.

Note: Frequency and type of follow-up for women (first 4 yrs) depends on their probability of becoming pregnant

<table>
<thead>
<tr>
<th>Visit Type</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>1\textsuperscript{st} Trimester</td>
<td>5 years</td>
</tr>
<tr>
<td>2\textsuperscript{nd} Trimester – Study Ultrasound</td>
<td>7 years</td>
</tr>
<tr>
<td>3\textsuperscript{rd} Trimester</td>
<td>9 years</td>
</tr>
<tr>
<td>Birth – Place of delivery</td>
<td>12 years</td>
</tr>
<tr>
<td>6 months</td>
<td>16 years</td>
</tr>
<tr>
<td>12 months</td>
<td>20 years</td>
</tr>
<tr>
<td>3 years</td>
<td>To be determined</td>
</tr>
</tbody>
</table>
Hypotheses->
Target Chemicals, Routes, Life-Stage

Indirect Measures (e.g., Community) or Questionnaires?

Environmental & Biomonitoring?
Importance of Route
Time represented by environ. & biological
Completeness of combined environ. & biological measures

Environmental?
Biomarker not available
Route of exposure is critical
Exposures can be more reliably/efficiently assessed using environ.

Biomonitoring?
Route of exposure not important
Biomarker reflects exposure over critical life stage(s)
Exposures more reliably assessed using a biomarker

Based on Ozkaynak, et.al., “Exposure Assessment Implications for the Design and Implementation of the National Children’s Study” Environmental Health Perspectives, 113: Aug, 2005
## Proposed “Core” Environmental Measurements

<table>
<thead>
<tr>
<th>Location</th>
<th>Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indoor Air (Residence, Child care locations)</td>
<td>Particulate Matter (PM$_{10}$) NO$_2$, O$_3$, VOCs, Aldehydes and Ketones</td>
</tr>
<tr>
<td>Outdoor Air (Community-level)</td>
<td>PM$_{2.5}$ NO$_2$, NO$_x$, SO$_2$, O$_3$</td>
</tr>
<tr>
<td>House Dust</td>
<td>Allergens, endotoxin, mold, metals, pesticides (+archive for future analyses)</td>
</tr>
<tr>
<td>Potable water</td>
<td>Disinfection byproducts (BBPs), Metals, Coliforms, Nitrate, Pesticides</td>
</tr>
<tr>
<td>Soil &amp; Food</td>
<td>Metals, pesticides</td>
</tr>
</tbody>
</table>
# Proposed Biomonitoring for Chemical Agents

<table>
<thead>
<tr>
<th>Sample Type</th>
<th>Analytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blood</td>
<td>PCBs, Persistent and non-persistent pesticides, PBDE, Perfluorinated compounds, PBDE flame retardant; Perchlorate; Lead, Mercury, Cadmium; Bisphenol A</td>
</tr>
<tr>
<td>Urine</td>
<td>PFBS, Alkyl phenols, Hg(inorganic), As(speciated), perchlorate, halogenated phenols (PCP), phthalates, atrazine, OPs, carbamates, pyrethroids, EBDC/ETU, Cadmium</td>
</tr>
<tr>
<td>Breast milk</td>
<td>Dioxins/furans; Organochlorine Pesticides; PCBs</td>
</tr>
<tr>
<td>Meconium</td>
<td>Cotinine, Organophosphate Metabolites</td>
</tr>
<tr>
<td>Nails</td>
<td>Mercury (organic, inorganic)</td>
</tr>
<tr>
<td>Hair</td>
<td>Cd, Cotinine, Mercury, Nicotine</td>
</tr>
</tbody>
</table>
# Proposed Questionnaire

## Topic Areas in the NCS

| Housing characteristics | Building age, renovations  
|                         | Heating/cooling systems/usage,  
|                         | Clothes dryer, Vaporizers, Air cleaners,  
|                         | Stove use,  
|                         | Water for drinking and cooking,  
|                         | Ozone sources,  
|                         | Vacuum cleaner use,  
|                         | Garage location and use,  
|                         | Gasoline exposure,  
|                         | Noise |
| Occupation/hobby        | Types of jobs, activities, exposures |
| Product use             | Creams/lotions that are widely applied;  
|                         | Cleaning products |
| Pesticide use           | Type, method, frequency of application, and use protective equipment;  
|                         | Number and types of pets, and exposure to flea/tick treatments |
## Proposed Questionnaire, Diary, or Observation

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visual assessment</td>
<td>Housing, neighborhood characteristics</td>
</tr>
<tr>
<td>Time and activity</td>
<td>Time spent at home, work/school, in-transit for work and non-work days</td>
</tr>
<tr>
<td>Diet</td>
<td>Food-frequency questionnaire, 3-day checklist, Infant feeding/intake, Eating behaviors (child)</td>
</tr>
<tr>
<td>Exposure-Related Topics</td>
<td>Environmental tobacco smoke, Take home exposures, Physical activity, Household composition and demographics</td>
</tr>
</tbody>
</table>
## Example Environmental Measures over Time

<table>
<thead>
<tr>
<th>Simplified Summary of Measures by Visit - Environmental Measurements</th>
<th>Pre-</th>
<th>Pregnancy</th>
<th>After Birth</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>T1</td>
<td>T2/T3 (self)</td>
<td>6-Mo (self)</td>
</tr>
<tr>
<td><strong>Indoor Air</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PM10/metals, carbon</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gaseous Air Pollutants</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>House Dust</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pesticides</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metals (store)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allergens, Mold, Pollen</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Drinking Water</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disinfection Byproducts (DBPs)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nitrate (private wells)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pesticides (private wells)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perchlorate (Community Level)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Soil</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-yard - Metal, Pesticide</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Others</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Visual Assessment</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Noise Survey</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Other Data Collections

- Community samples
  - Water
  - Air monitoring
  - Possibly food

- Specific settings outside of the home
  - Child care locations (probably on a subsample due to costs)
  - School (specifics not yet developed)

- Medical Record Abstraction
  - Complete abstraction of the mother and infant records at the time of delivery
  - Likely additional abstractions for a subset of events and/or outcomes
Design Considerations for Exposure Assessment in the NCS

- **Validation sampling** provides a statistical basis to adjust for error in exposure assessment when investigating exposure-outcome relationships.

- A **validation sample** is a small sample designed to provide information on the bias or error introduced by using alternative measures [or models] of exposure.

- Need to develop optimal **designs** and identify **surrogate measures** [, questionnaires, or models] and their relationship to “true” exposure.

Collections and storage protocols based on analytes specified in the hypotheses

Many analyses will be deferred
- Too costly and not necessary to have every analysis on every participant
- Many hypotheses can be addressed with nested case-control studies

Limited set of analytes require immediate processing
- Depends on stability of sample/analytes
Opportunities for Linking Biomonitoring to Risk Assessment and Public Health
Biomonitoring and the National Children’s Study

- Prime applications of biomarkers are epidemiological observational studies.
  - Relate biomarkers (at various times) to outcomes
- NCS requires and employs extensive use of biomarkers
  - Assays to test hypotheses
  - Repository of biological and environmental samples for future analyses and hypotheses
- Biomarker database - http://www.nationalchildrensstudy.gov/research/analytic_reports
- Evolving science and methodological developments = new improved measures & better science, e.g.:
  - EPA/NCER Early indicators of environmentally induced disease
  - NIEHS – Exposure biology Initiative
NCS and Risk Assessment

- NCS will address **important issues** for environmental risk assessment, such as:
  - Contribution of multiple exposures to childhood disease
  - Long-term health effects from early exposures
  - Factors that alter susceptibility (e.g., specific genetic polymorphisms, immune deficiencies)
  - Disparities in health outcomes (e.g., race, ethnicity, poverty, housing, income, nutrition)
  - Uncertainty factors and defaults in risk assessment for protecting children
NCA and Risk Assessment

- Directly links human exposure measures (biomonitoring and environmental) to health status, yielding better estimates for children, including the role of
  - Multiple “environments” and agents
  - Genetic factors and gene-environment interactions
- NCS will provide a rich data base for risk assessment, e.g.
  - Longitudinal exposure measures
  - Community-level cumulative risks
Conceptual Model: Exposures, Interactions, Mediators, and Outcomes

Exposures
- Chemical Exposures
- Physical Exposures
- Psychosocial Exposures
- Biological Exposures
- Genetics

Mediator Examples
- Gene Expression
- Health Care

Outcomes
- Pregnancy Outcomes
- Neurodevelopment and Behavior
- Asthma
- Obesity and Growth
- Child Health and Development
- Injury
- Reproductive Development
NCS and Public Health

- The NCS will identify not only what is harmful but what is helpful to children’s health
- Provides a national dataset linking source-exposure-effect
  - Evidence on which to base decisions about practice and policy regarding children’s physical and mental health
  - Allows evaluation of the consequences/effectiveness of regulatory decisions
- Economic benefits: disease prevention; cost avoidance
- Resource for future research
Environmental Public Health Paradigm

Pollutant Formation and Release from Source → Emissions Data → Transport/Transformation in the Ambient Environment → Ambient Data → Exposure/Contact:
- Individual
- Community
- Population → Personal Exposure → Entry into Body (Dose) → Biomarker of Exposure → Biomarker of Susceptibility → Altered Structure/Function → Biomarker of Effect → Adverse Outcomes: Mortality and Morbidity → Health Outcome Data

Source: Danelle T. Lobdell, US EPA, NHEERL
Environmental Indicators

Data Available

Level 1 Actions by EPA, State, and other regulatory agencies

Level 2 Actions and behavioral changes by regulated community

Level 3 Reduced amount or toxicity of emissions

Level 4 Improved ambient conditions

Level 5 Reduced exposure or body burden

Level 6 Improved Human or ecological health

Data Unavailable at present Time

Output Measures

Measures of Human/Eco-Health
NCS and Public Health Research

- Training for clinical, epidemiological, and environmental health research
- Consortia for combined research
- Public use and secondary data analysis
- Complimentary, not competitive, with investigator initiated research
- Platform for *adjunct studies*
What are *Adjunct Studies*?

- Uses NCS data, participants or their samples
- Outside of the “core” NCS protocol
- Generally supported with non-NCS funding
- NCS Program Office coordinates review and approval
- Requires participation of an NCS investigators
  - Study Centers, NCS Program Office, or ICC members
- Benefit of adjunct studies
  - Enhances breadth, depth and value of the NCS
  - Could use for linking biomonitoring and other exposure measures to sources
Use of Data to Maximize Output

- Publicly available results available ~2015
  - Hypothesis-specific (exposure-outcome) data analysis
  - Public-use data sets with support
- Successive funding for investigator initiated research and analyses
- Expected translation of results into related prevention initiatives
- Data analyses and adjunct studies may be needed
  - to link biomonitoring and exposure measures to sources
For more information about the NCS

Web site: www.nationalchildrensstudy.gov

Link on the home page that says “National Children’s Study Research Plan”

Click on link for “E-Updates” to join the listserv for news and communication

Email the study at ncs@mail.nih.gov